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/en/word/printing-documents/content/ Introduction When you're working on a multi-page document, there may be times when you want to have more control over how exactly the text flows. Breaks can be helpful in these cases. There are many types of breaks to choose from depending on what you need, including page breaks, section breaks, and
column breaks. Optional: Download our practice document. Watch the video below to learn more about using breaks in Word. In our example, the section headers on page three (Monthly Revenue and By Client) are separated from the table on the page below. And while we could just press Enter until that text reaches the top of page four, it could
easily be shifted around if we added or deleted something in another part of the document. Instead, we'll insert a page break. Place the insertion point where you want to create the page break. In our example, we'll place it at the beginning of our headings.On the Insert tab, click the Page Break command. You can also press Ctrl+Enter on your
keyboard.The page break will be inserted into the document, and the text will move to the next page. By default, breaks are invisible. If you want to see the breaks in your document, click the Show/Hide command on the Home tab. Section breaks Section breaks create a barrier between different parts of a document, allowing you to format each
section independently. For example, you may want one section to have two columns without adding columns to the entire document. Word offers several types of section breaks. Next Page: This option inserts a section break and moves text after the break to the next page of the document. Continuous: This option inserts a section break and allows you
to continue working on the same page.Even Page and Odd Page: These options add a section break and move the text after the break to the next even or odd page. These options may be useful when you need to begin a new section on an even or odd page (like with a new chapter of a book). In our example, we'll add a section break to separate a
paragraph from a two-column list. Place the insertion point where you want to create the break. In our example, we'll place it at the beginning of the paragraph we want to separate from two-column formatting.On the Page Layout tab, click the Breaks command, then select the desired section break from the drop-down menu. In our example, we'll
select Continuous so our paragraph remains on the same page as the columns.A section break will appear in the document.The text before and after the section break can now be formatted separately. In our example, we'll apply one-column formatting to the paragraph.The formatting will be applied to the current section of the document. In our
example, the text above the section break uses two-column formatting, while the paragraph below the break uses one-column formatting. Other types of breaks When you want to format the appearance of columns or modify text wrapping around an image, Word offers additional break options that can help: Column: When creating multiple columns,
you can apply a column break to balance the appearance of the columns. Any text following the column break will begin in the next column. To learn more about how to create columns in your document, review our lesson on Columns.Text wrapping: When text has been wrapped around an image or object, you can use a text-wrapping break to end the
wrapping and begin typing on the line below the image. Review our lesson on Pictures and Text Wrapping to learn more. To delete a break: By default, breaks are hidden. If you want to delete a break, you'll first need to show the breaks in your document. On the Home tab, click the Show/Hide command.Locate the break you want to delete, then place
the insertion point at the beginning of the break.Press the Delete key. The break will be deleted from the document. Challenge! Open our practice document.Scroll to the Revenue Projections section near the end of the document.Remove the page break after the Quarter 2 Projections by Client chart.Place your cursor at the beginning of the header
Web App Projections.Insert a Next Page section break.In the Page Setup group on the Layout tab, click the Columns drop-down menu and choose One. This formats the page back to one column and should allow the Web App Projections header and the table below it to span across the page. You will learn more about columns in our next lesson.When
you're finished, the last two pages should look something like this: /en/word/columns/content/ When you edit Microsoft Word documents, you may need to change the page layout for some of your pages, restart the automatic numbering or change the number of columns. In all these cases you need to introduce sections in your Word document. Read
this tutorial and find how to add, remove and manage sections in all your Word documents: NOTE: This tutorial applies to the desktop versions of Microsoft Word, found in Microsoft Office, and Office 365. It does not apply to the mobile versions of Word, like those found for free, on Windows 10 tablets, or on devices with Android and iOS. The section
breaks divide your Word document into separate parts that allow you to treat these parts as separate documents, with different properties. The section breaks can act as a page break and force a new page in Word, or they can be continuous, and the content that comes after these section breaks continues on the same page. Section breaks in
Microsoft Word Six features in Microsoft Word require section breaks. Four of them require a section break that acts as a page break: Changing the page margins Using different headers and footers Changing the paper size or orientation Changing the page numbering Other two features require section breaks that continue on the same page:
Changing or restarting numbering schemes Changing the number of columns If you introduce a continuous section break and then apply to the next section one of the four changes that require a page break, Word modifies your section break type automatically, from continuous to next page. Microsoft Word applies any of these changes only to the
current section (the one where your cursor is). If you want to apply this type of formatting for the entire document, make sure to select the whole document before activating the change. The section breaks are by default invisible when you edit Word documents. Just like the end of a line or page breaks, the section breaks are hidden because they
serve to organize your content and are not meant to be displayed or printed in the final result. While you edit your document, you may need to see them. To do that, first, make sure that the Home tab is active in the ribbon. Look for the Paragraph section and, in the right-top corner, press the Show/Hide button for formatting marks (it has a Pilcrow
sign - 1 - on it). The Pilcrow button in Microsoft Word The next, odd or even page section break appears at the end of your document's pages. Section break (Next page) in Microsoft Word The continuous section breaks can show up anywhere in your document, as highlighted in the screenshot below. Section break (Continuous) in Microsoft Word The
section breaks can be inserted from the Layout tab. First, make sure you position the cursor in the document, in the place where you want to start a new section. Click or tap the Layout tab on the ribbon. In the Page Setup section, locate the Breaks button and click or tap on it. A drop-down menu opens up, and the section breaks options are at the
bottom. Insert a section break in Microsoft Word There are four types of section breaks: Next Page - The new section after the break starts on a new page. Continuous - The new section continues on the same page. Even page/Odd page - They are similar to the Next Page break, except that it may insert a blank page to force the next page to be even or
odd, depending on what you choose. If you want to check what Word has done, press the Pilcrow (1) button in the Home tab (follow the instructions from the previous section). You are now ready to apply separate page, columns or numbering formatting for each section. Since the section breaks are hidden by default in Word, you need to show the
formatting marks to see them. Press the Pilcrow () button in the Paragraph section from the Home tab. The Pilcrow button in Microsoft Word The section breaks show up in the document so that you can identify and remove them. Once you identify the section break you want to eliminate, you can treat it as any other character in the document. You
can select it and delete it using the Delete or Backspace keys on your keyboard. Section break (Continuous) in Microsoft Word Microsoft Word stores the formatting specific to a section in the section break located at the end of it. If you delete the section break, the content of the section adopts the formatting of the next section immediately.
Remember that every Word document starts with one default section and the end of the document, that acts as the section break for it. You cannot delete the end of the document in Microsoft Word. As a result, you cannot delete in one go the formatting specific to the last section. The theory behind section breaks seems complicated, but it is easy to
manage them once you start to practice. As a rule of thumb, never create more sections than strictly necessary because making changes later on in your Word document becomes tedious. Keep in mind that the Header/Footer features allow, for example, different header or footer for the first page or for even and odd pages. You can apply such
formatting without inserting any new sections. In Microsoft Word, section breaks are meant to divide your book into sections. In books, they are used between chapters and to divide the front-matter or back-matter pages. Section break should be placed after the title page, copyright page, dedication page, table of contents, chapter 1, chapter 2, and
so on. These section breaks will create a page break between each of those sections. But it is not just a page break. Section breaks also control the page numbers within the section, running heads, and whether the next section begins on the next page or next right hand (odd numbered) page. Let’s look at each of those. Page Numbering Section
breaks allow you to control the numbering in each section. This lets you have page #1 be the first page of Chapter One. It also makes it possible to use lower case roman numerals for page numbers (i, ii, iii, iv, etc.) on the front-matter, and Arabic numerals (1, 2, 3, 4, etc.) on the chapter pages. Running Heads Each section has a first page, even page,
and odd page header. You can place different running head text in each one (or not have any). In a book, the first-page header should be left blank as this would be the chapter title page, the even page header often has the book title, and the odd page header the current chapter title or author name. when you use section breaks, you can have
different running heads in each section. This is useful for having the current chapter title for the running head of a section. You can also choose to link the current sections running head with the previous section if you want them to be the same. Where to Start the Next Section In a book, you often want to start the next section on the next right-side
page (odd page). You would do this in Word by placing a Section Break: Odd Page before the chapter or section you want to start on the next odd numbered page, which will be a ride-side page. Word will then place a blank left-side page (if needed) before that next chapter to make certain that happens. Take note! Word will not display a blank left-
side page in Normal view mode. This often confuses writers who don’t realize that that blank is there as they can’t see it. When you do a print preview, print, or create a PDF, Word will show the blank page. It is also reflected in the page numbering. You will notice that t seems that there is a missing page number. You might see a page 5, 6, 7, and
then it goes to a new chapter which is shown as page 9. Where is page 8? It is a blank left-side page that Word is not showing you. How to Insert a Section Break Here is how you place a section break. Place your cursor where you want the section break to be placed. For example, after the last sentence of a chapter, before the next chapter starts. In
the Word ribbon go to the Layout tab Click on Breaks From the drop down select either Next Page or Odd Page under Section Breaks. You will then see a Section Break marker appear in your document (if you have show formatting marks turned on) Start Chapter One on Page #1 Once your book is divided into sections, you can control the page
numbering with in. For example, let’s say you want Chapter One to start on page #1. Make sure your chapters are divided into sections then place your cursor in Chapter One. First, add page numbers to your section. Place your cursor where you want the page numbers to appear in the section (such as the footer area) From the Word ribbon go to the
Insert Click on the drop down for Page Number. Choose Current Position then Plain Number. Once your page number is where you want it, go back to that menu and select Format Page Numbers. Choose the Number format, then Start at: 1. Click OK. A Different Running Head for Each Chapter Let’s say you want to place the current chapter title on
the odd page running heads in your book. Here is how you would do that with the help of section breaks. First, make certain you have your document divided up by section breaks. Select all (press Ctrl + A) Go into Layout from the Word menu. Open the Page Setup Under the Layout tab under Headers and footers check both Different odd and even
and Different first page. Click OK. Next, go into the header area of your document for Chapter One. You can get there by double clicking in that ear of your Word document. Before you do anything else, make sure the Link to Previous toggle is NOT on. If it is on, it will link this running head with the running head in the previous section and they would
both be the same. Click it if needed to turn it off. Type your chapter title for this section in the header area. Click the Close Header Repeat that process for each chapter in your book. By the way, if you are hiring someone to do your book layout, don’t worry about having to do any of these things with section breaks. Your formatter will handle all of
that for you and is likely using Adobe InDesign, not Microsoft Word to format your book. Questions? Post them in the comment section below.



